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Foreword
This manual explains the functions and operations of GateMX/MW.  To ensure correct 
use, please read this manual thoroughly before beginning operation.  After reading the 
manual, keep it in a convenient location for quick reference whenever a question arises 
during operation.
GateMX/MW is a software program that monitors measured data from the MX100/
MW100 Data Acquisition Unit and supplies the data to DAQLOGGER or remote monitors.

Notes
•	 The contents of this manual are subject to change without prior notice as a result of 

continuing improvements to the instrument’s performance and functions.
•	 Every effort has been made in the preparation of this manual to ensure the accuracy 

of its contents.  However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA dealer.

•	 Copying or reproducing all or any part of the contents of this manual without the 
permission of Yokogawa Electric Corporation is strictly prohibited.

•	 Use of this software on more than one computer at the same time is prohibited.  Use 
by more than one user is also prohibited.

•	 Transfer or lending of this software to any third party is prohibited.
•	 Yokogawa Electric Corporation provides no guarantees other than for physical 

deficiencies found on the original disk upon opening the product package.
•	 License numbers will not be reissued.  Please keep the license number in a safe 

place.

Trademarks
•	 DAQWORX, DAQLOGGER, and DAQEXPLORER are registered trademarks or 

trademarks of Yokogawa Electric Corporation.
•	 Microsoft and Windows are registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
•	 Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems 

Incorporated.
•	 Company and product names that appear in this manual are registered trademarks or 

trademarks of their respective holders.
•	 The company and product names used in this manual are not accompanied by the 

registered trademark or trademark symbols (® and ™).

Revisions
•	 1st Edition		 December 2003
•	 2nd Edition		 February 2005
•	 3rd Edition		 March 2006 (Cover title changed)
•	 4th Edition		 June 2007
•	 5th Edition		 March 2008
•	 6th Edition		 January 2009
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Terms and Conditions of the Software License

NOTICE - PLEASE READ CAREFULLY BEFORE USE
Thank you very much for purchasing this medium containing a software program and related documentation provided by Yokogawa Electric Corporation (hereinafter called 
“Yokogawa”), and the program contained, embedded, inserted or used in the medium (hereinafter called the “Yokogawa Software Program”).
By installing the Yokogawa Software Program, you acknowledge that you understand and fully agree to the “Terms and Conditions of the Software License” (hereinafter called 
“Terms and Conditions”) which is written in the documentation and separately attached. Accordingly, the Terms and Conditions bind you.
The Yokogawa Software Program and its related documentation including ownership of copyright shall remain the exclusive property of Yokogawa or those third parties who 
grants Yokogawa the rights.
Yokogawa hereby grants you permission to use the Yokogawa Software Program on the conditions that you agree to the Terms and Conditions before you install it in or onto 
a computer.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS, YOU CANNOT INSTALL THIS MEDIUM, AND MUST PROMPTLY RETURN IT TO YOKOGAWA OR ITS 
DESIGNATED PARTY.

Terms and Conditions of the Software License
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software Program (hereinafter called the 
“Licensed Software”) to you on the conditions that you agrees to the terms and conditions stipulated in Article 1 hereof.
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions on the software license (hereinafter called the “Agreement”) when the 
Licensed Software is installed by the Licensee.
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event shall Yokogawa intend to 
sell or transfer the Licensed Software to the Licensee.

Article 1 (Licensed Software under these Terms and Conditions)
1.1	The terms and conditions stipulated herein shall bind any Licensee who purchases the Licensed Software on the condition that the Licensee consents to agree to the 

terms and conditions stipulated herein.
1.2	The “Licensed Software” and required number of license herein shall be specified in the following paragraphs (1) and (2) respectively. The Licensed Software means and 

includes all applicable programs and documentation, without limitation, all proprietary technology, algorithms, a factor, invariant, process and/or other know-how contained 
therein. These terms and conditions shall also govern any additional software to the Licensed Software inclusive of its version-up or revision-up if Yokogawa provides them 
to the Licensee.

(1)	Licensed Software Name: Data Acquisition Software Suite DAQWORX
(2)	Number of License: Same number as those media for the Licensed Software shall be acquired for installation.

Article 2 (Grant of License)
2.1	Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the license fee separately agreed 

upon by both parties.
2.2	The Licensee is, unless otherwise agreed upon in writing by Yokogawa, not entitled to change, sell, distribute, transfer, or sublicense the Licensed Software.
2.3	The Licensed Software shall not be copied in part or in whole except for keeping one (1) copy for back-up purpose. The Licensee shall secure or supervise the copy of 

the Licensed Software by the Licensee itself with great, strict, and due care.
2.4	The Licensed Software remains the exclusive property of Yokogawa and, if any, those of third parties from whom Yokogawa is sublicensed (hereinafter such third party’s 

software is called “Third Party Software”, which may include any software program made or coded by affiliates of Yokogawa). In no event shall the Licensee dump, reverse 
assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may translate the Licensed Software into other programs or change it into a 
man-readable form from the source code of the Licensed Software. Unless otherwise separately agreed upon by Yokogawa, Yokogawa shall not provide the Licensee the 
source code for the Licensed Software.

2.5	The Licensed Software and its related documentation inclusive of its ownership of copyright shall be the proprietary property of Yokogawa or a third party who grants 
Yokogawa the rights. In no event shall the Licensee transfer, lease, sublicense, or assign any rights relating to the Licensed Software.

2.6	Yokogawa may use or add copy protection in or onto the Licensed Software. In no event shall, regardless of the purpose, the Licensee remove or attempt to remove such 
copy protection.

2.7	The Licensed Software may include the Third Party Software. In the case that Yokogawa is granted permission to sublicense to third parties by any licensors (sub-licensor) 
of the Third Party Software under different terms and conditions than those stipulated in this  Agreement, the Licensee shall observe such terms and conditions of which 
Yokogawa notifies the Licensee in writing separately.

2.8	In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software, including any copy thereof.

Article 3 (Restriction of Specific Use)
3.1	The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for the purpose of the following 

events:
a)	 Operation of any aviation, vessel, or support of those operations from the ground;
b)	 Operation of nuclear products, its facilities and/or radiation apparatus;,
c) 	Operation of nuclear weapons, chemical weapons and/or biological weapons, or railroad; or
d)	 Operation of medical instrumentation directly utilized for humankind or the human body.

3.2	Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility for any claims or damages 
arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility, to solve and settle the claims and damages and to defend, 
indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses, damages and expenses (including fees for recalling the Products and reasonable 
attorney’s fees and court costs), or claims arising out of and related to the above-said claims and damages.

Article 4 (Warranty)
4.1	The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered. If defect(s), such as damage to the medium of 

the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed Software on condition that the defective Licensed 
Software shall be returned to Yokogawa’s specified authorized service facility within  12 month from the delivery of Yokogawa after opening the Package at the Licensee’s 
expense. As the Licensed Software is provided to the Licensee on an “as is” basis when delivered, in no event shall Yokogawa warrant that any information on or in the 
Licensed Software, including without limitation, data on computer programs and program listings, be completely accurate, correct, reliable, or the most updated.

4.2	Notwithstanding the preceding Paragraph 4.1, when Third Party Software is included in the Licensed Software, the warranty period and related conditions that apply shall 
be those established by the provider of the third party software.
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4.3	When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Release Upgrades specified by Yokogawa 
(hereinafter called “Release Upgrades”).

4.4	Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted renovation or improvement 
of the Licensed Software.

4.5	Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any failure of Yokogawa to 
comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the Third Party Software to Yokogawa (including any 
liability for direct, indirect, special, incidental or consequential damages) whether in warranty, contract, tort (including negligence but excluding willful conduct or gross 
negligence by Yokogawa) or otherwise with respect to or arising out of the use of the Licensed Software.

4.6	THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE, WRITTEN, ORAL, OR 
IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE ARE 
HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA.

Article 5 (Infringement)
5.1	If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under patent right (including utility 

model right, design patent, and trade mark), copyright, and any other rights relating to any of the Licensed Software, the Licensee shall promptly notify Yokogawa in writing 
to that effect.

5.2	In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate with the claiming party. 
Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s defense and negotiation. If and when such a claim 
should be attributable to Yokogawa, subject to the written notice to Yokogawa stated in the preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate 
with the claiming party at Yokogawa’s cost and expense and be responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 
5.1.

5.3	When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s judgment there is possibility of 
such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at Yokogawa’s cost and expense.

a)	 To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use the Licensed Software;
b)	 To replace the Licensed Software with an alternative one which avoids the infringement; or
c)	 To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right.

5.4	If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa shall indemnify the Licensee 
only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee. 

	 THE FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY SOFTWARE TO YOKOGAWA 
WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT LIMITED TO, PATENT AND COPYRIGHT.

Article 6 (Liabilities)
6.1	If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided to the Licensee under the 

conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this Agreement. However, in no event shall Yokogawa be 
liable or responsible for any special, incidental, consequential and/or indirect damage, whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, 
without limitation, loss of operational profit or revenue, loss of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of 
interruption of the Licensee’s business, substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of 
Licensee or other third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the extent of this 
Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee which Yokogawa has received. The 
Licensee agrees that Yokogawa shall be released or discharged from part or all of the liability under this Agreement if the Licensee modifies, remodels, combines with 
other software or products, or causes any deviation from the basic specifications or functional specifications, without Yokogawa’s prior written consent.

6.2	All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless Yokogawa is notified of the claim 
within one (1) year of its occurrence.

6.3	In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between the Licensee and its 
customers.

Article 7 (Limit of Export)
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other than those where Yokogawa 
permits export in advance.

Article 8 (Term)
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until terminated as provided herein, 
or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice to the Licensee. When aforesaid termination or cease is 
occurred, the Licensee shall immediately destroy and/or eliminate the Licensed Software and related documents without retaining any copies or extracts thereof. However, 
upon specifically instructed by Yokogawa, they shall be returned to Yokogawa or its designated third party.

Article 9 (Injunction for Use)
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems that the Licensed Software is 
used improperly or under severer environments other than those where Yokogawa has first approved, or any other condition which Yokogawa may not permit.

Article 10 (Termination)
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to perform this Agreement. 
However, Articles 5, 6, and 11 shall survive even after the termination.

Article 11 (Jurisdiction)
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably through negotiation 
between the parties upon the basis of mutual trust. Should the parties fail to agree within ninety (90) days after notice from one of the parties to the other, both parties hereby 
irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main office) in Japan for settlement of the dispute to the fullest extent allowed by applicable law.

Article 12 (Governing Law)
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely and irrevocably and to the 
fullest extent permissible under applicable law any rights against the laws of Japan which may have pursuant to the Licensee’s local law.

Article 13 (Severability)
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void with respect to 
the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect.

Terms and Conditions of the Software License
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How to Use This Manual

Structure of This Manual
This user’s manual consists of the following sections.

Chapter Title Description
1 Overview Gives an overview of the GateMX/MW functions. 

Describes the PC system requirements and system 
configuration that are required to use GateMX/MW.

2 Operating Procedure Describes the operating procedures of GateMX/MW.
3 Error Messages and 

Corrective Actions
Describes the error messages and their corrective 
actions.

Index An alphabetical index of the manual’s contents.

Scope of the Manual
This manual does not cover the basic operations of Windows XP, Windows 2000, and 
Windows Vista. For information regarding the basic operations of Windows, see the 
user’s guide that came with Windows.

Conventions Used in This Manual
•	 Unit
	 K 	 Denotes 1024.	 Example: 10 KB
	 M 	 Denotes 1024 K.	 Example: 10 MB
	 G 	 Denotes 1024 M.	Example: 2 GB

•	 Bold Characters
	 Bold characters are used for characters displayed on the software program screen.

•	 Subheadings
	 On pages that describe the operating procedure in Chapter 2, the following symbols 

are used to distinguish the procedure from their explanations.

			 

Procedure This subsection contains the operating procedure used to carry out
the function described in the current section. All procedures are
written with inexperienced users in mind; experienced users may
not need to carry out all the steps.

			   Note Calls attention to information that is important for proper operation 
of the instrument.
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Chapter 1	 Overview

1.1	 Functional Overview of the GateMX/MW

GateMX/MW is a software program that monitors data from the MX100/MW100 Data 
Acquisition Unit (MX100/MW100) and supplies the data to DAQLOGGER or remote 
monitors (software programs).  GateMX/MW enables you to monitor and logging the data 
that can be measured by the MX100/MW100 using DAQLOGGER or a remote monitor.

Note
DAQLOGGER is a software application that can connect various recorders (µR, VR, DARWIN, 
DX, MV, and CX models) and a PC for you to scan, record, and monitor the data.
Remote Monitor is a software application that is included in the DAQLOGGER Client Package 
or DAQ32Plus Client Package.  It can be used to monitor the data that has been acquired by the 
recorder or data acquisition software programs. Add-on software includes a variety of programs 
for customized monitors, network remote monitors, data acquisition and saving on a group basis, 
monitoring of measured data and triggered data acquisition, and other functions.

Features
•	 Up to 32 MX100s/MW100s can be connected.
	 The maximum number of connections from client programs (DAQLOGGER and 

remote monitors) is also 32.
•	 The monitor interval matches the measurement interval of the connected MX100.

* However, the fastest interval on DAQLOGGER is 1 second.
•	 The maximum number of data points that can be held per channel is 1800.

Note
•	 GateMX/MW does not contain functions for configuring the MX100/MW100.
	 To configure the MX100, use the MX100 Standard Software that comes standard with the MX100 

or MXLOGGER, a software program sold separately. Enter MW100 settings using the browser.
•	 GateMX/MW does not contain computation functions.
•	 GateMX/MW does not contain service functions that are available on other Gate programs.
•	 If you use the MX100 Standard Software or MXLOGGER, GateMX100 or GateMX/MW are 

displayed under the Software columns.

Procedure
To scan and record data from MX100/MW100 on DAQLOGGER, carry out the procedure 
given below.  If you are monitoring the data on a remote monitor, follow the instructions 
below and start the data monitoring on GateMX/MW.

		

Turn ON the 
MX100/MW100

Start the MX100 Standard 
Software or Browser

Set the MX100/MW100 
measurement conditions, etc.

Close the MX100 Standard 
Software or Browser

Connect to GateMX/MW
from DAQLOGGER

Start data monitoring
on GateMX/MW

Start logging on
DAQLOGGER

Set tags and other items
on DAQLOGGER

Start GateMX/MW

Register target
MX100s/MW100s

Retrieve info about the
 target MX100s/MW100s

Section 2.1

Section 2.2

Section 2.3

Section 2.4

Operations on GateMX/MW

Note
If you are changing the module configuration on the target MX100/MW100, stop the data monitoring 
on GateMX/MW and turn off the MX100/MW100 beforehand.  After changing the module configuration, 
turn ON the MX100/MW100 and reconfigure using the MX100 Standard Software or the browser.
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1.2	 System Overview

Software Requirements
Run DAQWORX under any of the following operating systems. 
•	 Windows 2000 Professional SP4
•	 Windows XP Home Edition SP2, SP3
•	 Windows XP Professional SP2, SP3 (excluding Windows XP Professional x64 Edition)
•	 Windows Vista Home Premium, SP1 (excluding the 64-bit edition)
•	 Windows Vista Business, SP1 (excluding the 64-bit edition)
The language displayed by the software under different language versions of the OS are 
as follows. 
OS Language Software Language
Japanese Japanese
Other English

Hardware Requirements
The following hardware is required for running GateMX/MW.
•	 PC:						�      A PC that runs one of the OS above, and that meets the 

following CPU and memory requirements. 
								        When Using Windows 2000 or Windows XP
								�        Pentium 4, 1.6 GHz or faster
								        512 MB or more of memory
								        When Using Windows Vista
								        Pentium 4, 3 GHz or faster
								        2GB or more of memory
•	 Free disk space: 	 200 MB or more
•	 Communication device: Ethernet port supported by the OS
•	 CD-ROM drive:		  The CD-ROM drive is needed to install the software.
•	 Peripheral devices:	 Mouse supported by the OS
•	 Monitor:					    When Using Windows 2000 or Windows XP
								�        A monitor supported by the OS of 1024 × 768 dot or higher and 

65,536 colors or more.
								        When Using Windows Vista
								�        A video card recommended for use with Vista and a monitor 

supported by the OS of 1024 × 768 dot or higher and 65,536 
colors or more.
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1.2  System Overview

System Configuration

		

MX100

MX100

MX100

Connect up
to 32 units

Hub
MX100/MW100 Data
Acquisition Unit

GateMX/MW
PC

DAQLOGGER/
remote monitor

PC

Ethernet

Up to 32
connections

It is recommended that GateMX/MW and DAQLOGGER be run on different PCs to 
distribute the load.

Software Configuration

	

MX100/MW100

DAQLOGGER

Remote monitor

Ethernet

Ethernet

Monitor data
from the 
MX100/MW100

Ethernet

Ethernet

Add-on Software

GateMX/MW

Configure
the MX100

Ethernet

MX100 Standard 
Software

or
MXLOGGER

Configure
the MW100

Ethernet

Browser Deliver the data

GateMX/MW monitors data from multiple MX100s/MW100s that are connected. It also 
acts as a monitor server to deliver the data to DAQLOGGER, remote monitors, or Add-on 
Software.
GateMX/MW does not contain functions for configuring the MX100/MW100. To configure 
the MX100, use the MX100 Standard Software that comes standard with the MX100 
or MXLOGGER, a software program sold separately. Enter MW100 settings using the 
browser. In addition, GateMX/MW does not contain computation functions.
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Chapter 2	 Operating Procedure

2.1	 Starting and Exiting GateMX/MW

Procedure
Starting GateMX/MW
Choose Programs > YOKOGAWA DAQWORX > GateMXMW > GateMXMW from the 
Windows Start menu.
The window shown below opens.

		

Note
•	 GateMX/MW starts up in the condition that existed immediately before you closed GateMX/

MW the previous time.
•	 If the program is closed while a process or service is running, the license will be considered 

to be “in use.” If the message, “Invalid license number. Please reinstall.” appears when 
restarting the program, it may indicate that the user is attempting to run a Gate program in 
excess of the number of available licenses.

Starting GateMX/MW in Acquisition Start Mode
1.	 From the Windows Start menu, choose Programs > YOKOGAWA DAQWORX 

> GateMX/MW > GateMX/MW, then right-click GateMXMW and select Create 
Shortcut.  

2.	 Right-click the shortcut icon and select Properties.  
3.	 Choose the Shortcut tab, then add /START to the right of the path in the Target 

box and click OK.  

					   

4.	 Choose the shortcut from the Windows Start menu.  The connection status of the 
previous session is restored, and acquisition begins. 

Exiting GateMX/MW
Choose Exit from the File menu or click the “X” button at the right corner of the title bar.
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2.2	 Registering MX100s/MW100s

Before carrying out the procedure below, connect the target MX100/MW100 to the 
Ethernet network and turn its power ON.  Configure the MX100 in advance using the 
MX100 Standard Software that comes standard with the MX100 or MXLOGGER, a 
software program sold separately. Enter MW100 settings using the browser.

Procedure
1.	 Click the Search button.

	 MX100s connected to the network are listed under MX100 nearby

				  

Click

Click to sort by the item name

Note
If a user is already connected to an MX100/MW100, the corresponding computer name and 
MX100/MW100 software application name are displayed under the User and Software columns, 
respectively.  You cannot use GateMX/MW to connect to an MX100/MW100 that already has a 
connected user.

2.	 Drag the machine name of the MX100/MW100 you wish to connect from the 
MX100/MW100 nearby list and drop it onto the MX100/MW100 unit list area.

	 When registered, the IP address of the target MX100/MW100 appears in the IP 
Address/Host column in the MX100/MW100 unit list area.
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Note
•	 You can also register MX100s by entering the IP address or host name directly in the IP 

Address/Host column.
•	 As shown in the figure below, you can select multiple numbers in the No. column and click 

the button below the IP Address/Host column to register incrementing IP addresses starting 
from the IP address of the first number in the selected range.  If a host name is displayed for 
the first number in the selected range, the same host name is registered for all the numbers 
in the selected range.

					   

Select

Click

2.2  Registering MX100s/MW100s
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2.3	 Retrieving Information about the Target 
MX100s/MW100s and Setting the Number of 
Channels and the Monitor Interval

Before carrying out the procedure below, register the target MX100s in advance 
according to the instructions given in section 2.2, “Registering MX100s/MW100s.”

Procedure
1.	 Click the Get Info. button in the Info column in the MX100/MW100 unit list area.

	 When the retrieval of the information is complete, the MX100/MW100 machine 
name appears in the Machine Name column.

					   

Click

Note
•	 If the MX100/MW100 from which you are attempting to retrieve information is already 

connected by another user or if the MX100/MW100 does not exist on the network, the 
information cannot be retrieved. The number of the channel is displayed as 0 and the 
system, hardware, and machine name do not appear.

•	 As shown in the figure below, you can select multiple numbers in the No. column and click 
the button below the Info. column to retrieve information of multiple registered units.

					   

2. Click

1. Select

•	 The information is retrieved again from the registered MX100/MW100 when data monitoring 
is started.

2.	 To change the number of channels after information is retrieved, click in the Num. 
of Ch. column and enter the number. If you wish to change the monitor interval 
settings, click the button in the System column to display the list and select a 
monitor interval. When the number of channels is changed, the display in the 
Channel tab will be modified.

					   

Click here to enter the value
Click here to select from the list

Copy the settings of the first channel 
in the selected range to all other channels in the range
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Note
You can set multiple monitor intervals in the same system. If the same monitor interval is set for 
the MW100, it is assigned to each system in order from smallest measurement group number. 
Also, if the number of same monitor intervals is greater than the actual number of measurement 
groups, only the actual number of measurement groups is valid.

2.	 To display channel information, click the Channel tab.

	 You can also choose Channel from the View menu.

	

Click

Click the number to highlight the channel information
of the corresponding unit

Highest two digit: Registered unit number
Lowest three digit: Channel number (000 to 099), Math channel (more than 100)

Note
•	 The channel information is displayed only for channels that are set to acquire data in the 

MX100/MW100 settings.
•	 If the number of channels set in step 2 exceeds the actual number of channels that exists 

in the MX100/MW100, the portion of nonexistent channels is left blank. If the number of 
channels is less than the actual number of MX100/MW10 channels, only the set channels 
are displayed.

•	 If the connection fails, the channel information for the corresponding MX100/MW100 
appears as a blank line.

•	 If the channels of the modules installed to the MX100/MW100 do not match the channels 
displayed in the Channel tab, perform reconfiguration using the MX100 Standard Software 
or the Browser.

•	 The System No. from the channel information display is shown when information is retrieved 
or when setting the System column in the System Configuration screen.

•	 Click System No. to sort the channel information by system number.  Click System No. 
again to sort the channel information by channel number.

Click here to sort the 
channel information 
by system number

2.3  Retrieving Information about the Target MX100s/MW100s and Setting the Number of Channels and the Monitor Interval
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2.4	 Starting/Stopping Data Monitoring

Before carrying out the procedure below, retrieve the channel information of the target 
MX100s in advance according to the instructions given in section 2.3, “Retrieving 
Information about the Target MX100s/MW100s.”

Procedure
Starting Data Monitoring
Click the Start Monitoring button or choose Start Monitoring from the Monitoring menu.

		

Click

Note
•	 If GateMX/MW is connected to the MX100, Backup mode will not be enabled when the 

communication is cut while monitoring data. Even if the /DS option is enabled, the Dual 
Save feature will not operate.

•	 If the initial communication with the target fails, retry ten seconds after the communication 
failure is confirmed. Additional time is required from the start of communication until the 
failure is recognized.

Displaying Run Status While Monitoring Data
Click the Run tab.
You can also choose Run from the View menu.

Click

Monitor interval specified on the MX100
The maximum and minimum channel numbers of the channel range assigned
to the same monitor interval.

The number of channels assigned to the same monitor interval

Number registered in the MX100 unit list under System.

Computer name of the PC running the
client software that is connected
(Maximum number of connections: 16)

Assigned system number

Acquisition Status
  Green: Normal (running)
  Red: Error (stopped, not able to connect, or there is no 
                      corresponding channel to monitor data.)
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Note
•	 The color of the unit numbers under Communication Status indicates the following 

conditions.
  Gray (characters in dark gray):	� There is no IP address or host name specified 

for the MX100/MW100 with that unit number 
(specification is blank). Or, there is an IP address 
or host name specified but the number of channels 
and system is not specified. 

  Green:			�   Communication with the MX100/MW100 is normal, 
and data is being monitored.

  Red:			�   There is an IP address or host name specified for 
the MX100/MW100 with that unit number, but the 
connection failed. Or, communication was cut while 
monitoring data, and now attempting to reconnect.

  Black:			�   There was an IP address or host name specified for the 
MX100 with the unit number and connection succeeded, 
but there were no channels set to acquire data.

	 If the icon is displayed in red, try the connection again.  If reconnection is successful, the 
icon turns green and acquisition resumes.  

	 When acquisition stops, all characters turn gray (characters in dark gray).  When acquisition 
resumes, registered items blink.  The gray color of unregistered items remains unchanged 
(characters in dark gray).  

					     blinks. does not change.↓ ↓

•	 The status of GateMX/MW is displayed in the status bar.  You can check the communication 
status displayed in the Run tab.  

Connection with MX100/MW100 normal

Connection with MX100/MW100 abnormal

Reconnecting with MX100s/MW100s 
(only displayed during communication) 

Number of connected clientsCondition status

•	 System numbers are assigned on the GateMX/MW System Configuration screen as shown 
in the figure below. Since four monitor intervals can be specified on each MX100/MW100, 
the system numbers are assigned in the range from 0 to 127.

	

MX100 of Unit No. 00

System No.1 2 3 4 5 6 7

100 ms 200 ms 500 ms 100 ms 200 ms 500 ms 1 sMonitor
interval

MX100 of Unit No. 01 MX100 of Unit No. 02

•	 Interval groups with the same monitor interval can be configured on the MX100 Standard 
Software (See the MX100 Standard Software User’s Manual (IM MX180-01E)).  A single 
interval group is displayed as a single system on GateMX/MW.

2.4  Starting/Stopping Data Monitoring
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1 s 100 ms

Settings on the MX100 Standard Software

Interval
group 1

Interval
group 2

1 s

Interval
group 3

100 ms

MX100

1 s

Displayed on GateMX/MW

System No. Unit No. Channel Range Interval Num. of Ch.
0
1

00
00

100 ms
1 s

•	 If a monitor interval longer than 1 minute is specified on the MX100 Standard Software, 
the monitor interval on the MX100 is set to 1 minute and the monitor interval longer than 1 
minute is achieved by decimating the data on the MX100 Standard Software.  Therefore, 
even if a monitor interval longer than 1 minute is specified on the MX100 Standard Software, 
the monitor interval is displayed as 1 minute on GateMX/MW, and the data is monitored at 
1-minute intervals.

1 s 100 ms

Settings on the MX100 Standard Software

Interval
group 1

Interval
group 2

1 hour

Interval
group 3

100 ms

MX100

1 s

Displayed on GateMX/MW

System No. Unit No. Channel Range Interval Num. of Ch.
0
1

00
00

100 ms
1 s

2 00 1 min

1 min

•	 If the interval group of different monitor intervals are set on the MX100 Standard Software, the 
MX100 sorts them by monitor intervals from fastest to slowest. Consequently, the GateMX/
MW also assigns system numbers in order from fastest to slowest monitor interval when 
retrieving the information on the System Configuration screen. If the system is set or changed 
on the System Configuration screen, the system numbers are assigned in the set order.

1 s 500 ms

Settings on the MX100 Standard Software

Interval
group 1

Interval
group 2

100 ms

Interval
group 3

100 ms

MX100

500 ms

Displayed on GateMX/MW

System No. Unit No. Channel Range Interval Num. of Ch.
0
1

00
00

100 ms
500 ms

2 00 1 s

1 s

Stopping Data Monitoring
Click the Stop Monitoring button or choose Stop Monitoring from the Monitoring menu.

		

Click

2.4  Starting/Stopping Data Monitoring
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2.5	 Connecting to GateMX/MW from DAQLOGGER,  
Remote Monitor, or Add-on Software

While data is being monitored by GateMX/MW, DAQLOGGER and remote monitors can 
log or monitor the MX100/MW100 data via the Ethernet network.  GateMX/MW operates 
as a monitor server for DAQLOGGER, remote monitor clients, and Add-on software.

Connecting to GateMX/MW from DAQLOGGER
See section 2.6 in the WX101 DAQLOGGER WX81 DAQLOGGER Client Package 
User’s Manual (IM WX101-01E).

Note
There are two methods to connect to GateMX/MW from DAQLOGGER.  One method is to 
specify the system number; the other is not to specify the system number.  For the procedure 
of selecting the connection method, see section 2.6 in the WX101 DAQLOGGER WX81 
DAQLOGGER Client Package User’s Manual (IM WX101-01E).
•	 Connecting to GateMX/MW by specifying the system number
	 Of the MX100s/MW100s connected to GateMX/MW, only the channel data with the specified 

system number is monitored.

DAQLOGGER

GateMX/MW

1 2 3 4 5 6 7

100 ms 200 ms 500 ms 100 ms 200 ms 500 ms 1 s

When monitoring data only from
the channels with system
numbers 3 and 5

3 5 System No.

MX100 of Unit No. 00

System No.

Monitor
interval

MX100 of Unit No. 01 MX100 of Unit No. 02

•	 Connecting to GateMX/MW without specifying the system number
	 The data of all the channels of the MX100s/MW100s connected to GateMX/MW is monitored 

using one connection.

DAQLOGGER

GateMX/MW

100 ms 200 ms 500 ms 100 ms 200 ms 500 ms 1 s

When monitoring data from
all the channels

1 2 3 4 5 6 7

MX100/MW100 of 
Unit No. 00

System No.

Monitor
interval

MX100/MW100 of 
Unit No. 01

MX100/MW100 of 
Unit No. 02

Connecting to GateMX/MW from the remote monitor
If you are connecting to GateMX/MW from the remote monitor of the DAQLOGGER 
Client Package, see section 8.1 in the WX101 DAQLOGGER WX81 DAQLOGGER 
Client Package User’s Manual (IM WX101-01E).
If you are connecting to GateMX/MW from the remote monitor of the DAQ32Plus Client 
Package, see section 9.2 in the WX102 DAQ32Plus WX82 DAQ32Plus Client Package 
User’s Manual (IM WX102-01E).

Connecting to GateMX/MW from the Add-on Software
If you are connecting to GateMX/MW from the Add-on software, see the user’s manual 
for the relevant product.
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2.6	 Changing the Port Number and Saving the 
Settings

Procedure
Changing the Port Number
Carry out the procedure below if you wish to change the TCP/IP port number that is used 
by DAQLOGGER or remote monitors to connect to GateMX/MW.

1.	 From the File menu, choose Port No..
	 The Port No. dialog box opens.

2.	 Enter the port number used for the monitor server.

	 The default value is 50297.

					   

3.	 Click OK and restart GateMX/MW.

	 You must restart GateMX/MW to activate the new port number.

Saving the Settings
From the File menu, choose Save or Save As.
If you choose Save As, enter the file name in the dialog box that appears and save the 
file.

		

Note
If you choose Save when you have not saved to a specific file name before, the same dialog 
box that opens as when you choose Save As opens.

Changing to the Saved Settings
From the File menu, choose Open.  Select and open the desired file in the dialog box 
that appears.
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2.7	 Showing Version Information

Procedure
Click the About button on the toolbar or choose About from the Help menu.

		

Display version information

The About dialog box opens as shown below.

		

Version

Company name
User name
License number
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Chapter 3	 Error Messages and Corrective Actions

3.1	 Error Messages and Corrective Actions

This section describes the messages and their corrective actions when errors occur.

Code Description Action
E0002 Insufficient memory.  Please exit 

immediately.
Close other software programs and restart GateMX/MW.  Or, restart 
Windows.

E0211 Cannot write to the file. Check whether there is sufficient space on the hard disk, whether writing is 
permitted, and whether the file system is operating normally.

E4800 The maximum limit of Gate 
programs running simultaneously 
has been exceeded.

The number of Gate programs that you can run simultaneously is limited by 
the Gate software license that you have purchased. Close a Gate program 
that is already running or purchase a new license and reinstall the program.
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